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What’s New in
Chief Architect X8

Welcome to Chief Architect X8. This guide has been written to help our upgrading 
customers make a smooth transition from earlier versions of Chief Architect to Chief 
Architect X8. 

•      Before You Begin
•      New and Improved Features

Before You Begin
There are many new features in Chief Architect X8, and many existing features have 
changed. These changes affect the way Chief Architect functions, so it is very important to 
be familiar with them. 

• “Getting Started Check List” on page 2

• “Files Created in Version X7 and Prior” on page 4

• “Files Created in Version X6 and Prior” on page 5

• “For Files Created in Version X5 and Prior” on page 5

• “For Files Created in Version X4 and Prior” on page 5

• “For Files Created in Version X3 and Prior” on page 6

• “For Files Created in Version X2 and Prior” on page 7

Chief Architect X8 can open the .plan, .layout, .PL1, and .LA1 files from prior versions. 
Before opening any files created in earlier versions of Chief Architect, it is important to be 
aware of changes made in the newest version and the effect they may have on your legacy 
plan and layout files. For details, see “Files Created in Version X7 and Prior” on page 4, “For 
Files Created in Version X2 and Prior” on page 7. 

Please note that files saved in the latest program version cannot be read by older versions 
of the software. When a legacy file is saved in the version X8, an unaltered copy of the 
original file is created which can still be opened in the original version.
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As in all software, every new program version introduces changes to its functionality as well 
as to the user interface. If you choose to bring a project forward, be sure to take a few 
moments to look it over in the new version and confirm that the new functionality does not 
require you to make any modifications. Particularly if you have an approaching deadline, 
you may find it best to finish the current project in the version of the software in which you 
began it. 

Getting Started Check List
The following checklist suggests steps you should take before migrating your files to Chief 
Architect X8. More information about each of these steps can be found after the checklist.

1.      Check for and Install Program Updates
2.      Migrate Legacy Library Files
3.      Migrate Custom Graphics Files
4.      Review the New Features List
5.      Review Your Preferences Settings
6.      Create new custom Template Plan and Layout files
7.      Set up Custom Toolbar Configurations
8.      Backup Entire Plan
9.      Check chiefarchitect.com for more information

1. Check for and Install Program Updates

Program updates contain improvements to the original release version and we recommend 
using the most current version available. By default, Chief Architect checks for program 
updates every day when you launch the program. Please note that program updates are 
available for download, which means that you need internet access to acquire them.

You can check for updates at any time: 

• Select Help> Download Program Updates from the menu. 

• Visit the Program Updates page on the Chief Architect Web site at chiefarchitect.com. 

2. Migrate Legacy Library Files 

Library content from previous program versions cannot be installed or copied into the Chief 
Architect X8 library. If you upgraded from version X1 or later and have custom library 
content on your computer from that program version, the program installer will locate it 
and ask if you want to migrate it into the Chief Architect X8 library.  

You can import library files from versions X1 through X5 at any time by selecting Library> 
Import Library (.calib, .calibz) from the program menu. In addition, library files from 
versions 10 and prior can be imported by selecting Library> Convert Legacy (.alb) Library 
Files from the program menu.

3. Migrate Custom Graphics Files

If you have custom graphics files, including textures, images or backdrops, that you were 
using in a previous program version, you can copy them manually using your operating 
system for use in Chief Architect X8. 

http://www.chiefarchitect.com/
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• Copy custom texture files to the Chief Architect X8 Textures folder located in the Chief 
Architect X8 Data folder. 

• Copy custom image files to your Chief Architect X8 Images folder located in the Chief 
Architect X8 Data folder. 

• Copy custom backdrop files to your Chief Architect X8 Backdrops folder located in the 
Chief Architect X8 Data folder. 

In Chief Architect X7 through X1, custom graphics were saved in the Chief Architect Data 
folder, as they are in version X8. In version 10 and prior, they were located in the program’s 
installation directory, in folders that began with “My”. Custom backdrops, for example, 
were saved in “My Backdrops”. 

Texture and image files are not listed in the Library Browser. These files can be assigned to 
material and image objects, however, which are stored in the library so it is important to 
retain them.

4. Review the New Features List 

There are a number of important reasons why you should familiarize yourself with the new 
and improved features in Chief Architect X8:

• New and improved features allow you to produce drawings more efficiently, so it is to 
your advantage to use them. 

• Some changes to existing functionality may affect your accustomed drawing style and 
thus your productivity if you are not aware of them. 

• New features may affect your choice of settings in your template files, as well as your 
preferred Preferences settings. 

See “New and Improved Features” on page 8. 

5. Review Your Preferences Settings 

Any changes that you made to the Preferences settings in your previous version do not 
migrate into Chief Architect X8. You should review all the settings in the Preferences dialog 
to make sure that they are set to suit your drawing needs.

6. Create new custom Template Plan and Layout files 

Chief Architect X8 installs a selection of template plan and layout files that have been set up 
to take advantage of the program’s updated tools and features. For best results, it is 
recommended that you either: 

• Use the installed templates when creating new plans and layout files in Chief Architect 
X8

• Use the installed templates as the basis for creating new custom templates.

If you choose to continue using custom template files that you created in a previous 
program version, it is very important that you take the time to carefully review all the 
default settings in the file, making sure that they will continue to suit your needs in X8. 
First, make copies of your custom templates in the Chief Architect X8 Templates directory 
The Templates directory is located in the Chief Architect X8 Data folder. Next, open each 
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template as you would a regular plan or layout file, by selecting File> Open, and then save 
any changes you make by selecting File> Save.

If you do choose to continue using a legacy template plan, it is best to also use a legacy 
layout template from the same program version, as well. As with a template plan, take the 
time to go through the layout template’s defaults and make sure they are suited for use in 
X8 and that their line weight scales do not conflict with those in your template plans.

7. Set up Custom Toolbar Configurations 

It is possible to migrate toolbar configuration files from previous versions to Chief Architect 
X8; however, it is not recommended because it is likely that you will be missing new tools 
available in version X8. 

Instead, we recommend that you set up your custom toolbars the way you would like them 
in Chief Architect X8. You may find it most effective to customize your toolbars as you get 
used to working in the new program version, rather than beforehand.  

8. Backup Entire Plan

Before migrating a legacy file created in Chief Architect X7 or prior, it is a good idea to open 
the plan in the program version in which is was created and use the Backup Entire Plan tool 
(Export Entire Plan in version X3 and prior) to export the plan with all associated support 
files, including textures, backdrops and images.  

9. Check chiefarchitect.com for more information

If you have additional questions about the changes in Chief Architect, up to date 
information is available in the Support section of our web site. You can also post questions 
on the ChiefTalk web forum at chieftalk.chiefarchitect.com.

Files Created in Version X7 and Prior
In addition to the above recommendations, if you wish to open files created in Chief 
Architect Version X7 or prior, bear in mind the following before you open legacy files in 
Chief Architect X8. 

1. Boxed Eaves

In Chief Architect X8, improvements to the generation of Boxed Eaves ensure that they 
extend into exterior rooms with “Use Soffit Surface for Ceiling” specified when located 
between the roof baseline and an interior room. In some legacy plans opened in Version X8, 
the Length value for Boxed Eaves may need to be modified in the Roof Plane Specification 
dialog.

2. Uppercase Text

The Uppercase option was added to Text Styles in Version X8, whereas in Version X7 and 
prior, it was an option for Room Labels and Schedules only. In legacy plans opened in 
Version X8, any Schedules present in the drawing will be assigned a Custom Text Style, as 
will their associated Schedule Defaults. If any Schedule Default is set to Use Layer for Text 
Style and no objects are present on that layer, a new Schedule Text Style will be created and 
assigned to that layer. Room Labels are treated similarly: if any are present, they and their 
defaults will use a Custom Text Style. If a given Room Label or Schedule has been sent to 

https://chieftalk.chiefarchitect.com/
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layout more than once and was set to use different Text Styles in each layout view, it is 
possible that its appearance may be affected in some views.

Files Created in Version X6 and Prior
In addition to the above recommendations, if you wish to open files created in Chief 
Architect Version X6 or prior, bear in mind the following before you open legacy files in 
Chief Architect X8. 

1. Built-in Appliances

In Chief Architect X6 and prior, some appliance symbols designed to be inserted into base 
cabinets had incorrect sizing data. In legacy plans opened in version X8, these appliances 
will not fit into the cabinet correctly and will need to be replaced. Built-in dishwashers are 
particularly affected.

2. Formatting of Bulleted and Numbered Lists

In Version X7, various improvements were made to the way lines of Rich Text are spaced. In 
legacy plans opened in Version X7, Rich Text objects with bulleted and numbered lists may 
require adjustments.

3. Chief Blueprint Font

The Chief Blueprint font was improved for Version X6, with decreased top and bottom 
spacing. The change in spacing may increase the overall height of text objects using this font 
in X6 files opened in Version X8. X5 and prior legacy files will not be affected by this change.

For Files Created in Version X5 and Prior
In addition to the above recommendations, if you wish to open files created in Chief 
Architect Version X5 or prior, bear in mind the following before you open legacy files in 
Chief Architect X8. 

1. Named Values for Doors and Windows

In Version X6, the Named Values door_style_name, door_type_name, and 
window_type_name were shortened to style_name and type_name. Any object labels or 
text macros using these Named Values in legacy plans opened in Version X8 will need to be 
replaced.

For Files Created in Version X4 and Prior
In addition to the above recommendations, if you wish to open files created in Chief 
Architect Version X4 or prior, bear in mind the following before you open legacy files in 
Chief Architect X8. 

1. Roof Overhangs and Framing

In Chief Architect X4 and prior, roof overhangs were measured to the outside of the 
subfascia, whereas in Version X5, they are measured to the outside of the fascia or shadow 
boards, if present. In legacy plans opened in Version X5, this will not affect the appearance 
of roof planes in floor plan view because in X4 and prior, roof plane polylines represented 
the projected framing area whereas in Version X5 they represent the total projected area. 
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But, the position of the fascia and subfascia will shift, as will the length of the rafters.

2. Door Swing Direction and Materials

In Chief Architect X4 and prior, exterior doors that swing outward display interior material 
on exterior side of door. This was corrected in Version X8. Doors modified to work around 
the old behavior could be affected in legacy plans opened in Version X5.

3. Door Swing Direction and Louvers

Improvements to door louver direction may affect louvers in all doors with the exception of 
bifold doors.

4. Wrapped Door/Window Lintels and Window Sills

In Chief Architect X4 and prior, wrapped lintels and sills extended out further than those 
that were not wrapped. In legacy plans opened in Version X8, the extents of wrapped lintels 
and sills will be adjusted so that they equal their Extend setting.

5. Cabinet Feet

The offsets for cabinet foot millwork symbols in Version X4 and prior were set per millwork 
symbol to insert into cabinets effectively. In Version X8, the offset is set in the Cabinet 
Specification dialogs. When legacy plans are opened in Version X5, cabinet foot offsets are 
set to 0 and transferred to their containing cabinet, if one exists. Any customized or 
independently placed cabinet feet will be affected.

6. Object Labels in Cross Section/Elevation Views

If a “Label” layer is turned on in a cross section/elevation view and objects of that type are 
visible in the view, then those objects’ labels will display in that view when the plan is 
opened in Version X8.

7. Transparent Materials

In Chief Architect X4, materials assigned to the Transparent Material Class for ray tracing 
were visible in rendered views even when their Index of Refraction was set to 1.0. When 
legacy plans are opened in Version X8, Transparent materials with an Index of Refraction of 
1.0 are transferred to the General Material class and assigned a Transparency value of 
100%. This will not affect these materials’ appearance in ray trace views, but will make 
them completely invisible in rendered views.

8. Invisible Beams

The legacy Invisible Beam checkbox was removed from the Wall Specification dialog. When 
legacy plans are opened in Version X8, any Invisible Beam walls will be converted to 
Invisible Walls. 

For Files Created in Version X3 and Prior
In addition to the above recommendations, if you wish to open files created in Chief 
Architect Version X3 or prior, bear in mind the following before you open legacy files in 
Chief Architect X8.
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1. Text Styles

The appearance of a number of objects that include text - including object labels, the North 
Pointer, Sun Angles, Joist Direction Lines, the Up/Down arrows for stairs and ramps - can 
now be controlled using Text Style. Their appearance may be altered somewhat in legacy 
plans opened in Chief Architect X8.

2. Light Sources

The illumination created by light fixtures and Added Lights was improved in Chief Architect 
X8. Lighting in legacy plans may appear noticeably brighter when viewed in version X8.

For Files Created in Version X2 and Prior
If you wish to open files created in Chief Architect Version X2 or prior, bear in mind the 
following file management changes and structural enhancements before you open legacy 
files in Chief Architect X8.

1. Material textures, images, and backdrops

Chief Architect X2 and prior installed with a catalog of library content, including a selection 
of material textures, images, and backdrops. This library catalog is no longer installed with 
the program because it is now available for download on-demand, so it will be possible to 
open a legacy plan in version X8 and encounter numerous missing file warnings. To avoid 
this, we recommend using the Export Entire Plan feature in the original program version to 
create a folder that includes the plan and all associated textures, images, and backdrops 
before opening this file in X8. This tool is renamed Backup Entire Plan in version X8.

2. Floor and ceiling finish thicknesses

In Chief Architect X2 and prior, floor and ceiling finish layers were not modeled in 3D, and 
objects such as railings, stairs, landings, cabinets, fixtures, and furnishings measured their 
Floor to Bottom height from the subfloor. These objects now measure their Floor to Bottom 
height from the floor finish surface by default, so it is possible that you may notice height 
changes for these objects - particularly in saved, annotated cross section/elevation views.

3. Riser heights and landing thicknesses

The default Best Fit Riser Height for stairs that do not reach the next level has been updated 
from 9” (225 mm) in version X2 and prior to 6 3/4” (169 mm) in Chief Architect X8.

4. Auto Adjust Height

The Follow Terrain option in some specification dialogs was replaced by the Auto Adjust 
Height checkbox. If a cabinet, fireplace, fixture, furniture, or other library symbol had 
Follow Terrain unchecked in version X2 or prior and was located in a room with a floor 
height other than the default for the current floor, then the object’s Floor to Bottom Height 
will change to equal that room’s floor height. The object’s position in the model will not 
change, however. 

5. Adjustable Thickness Walls

In Chief Architect X2 and prior, generic, single-layer wall types were available for use. When 
a legacy plan file is opened in version X8 and these wall types are detected, they are 
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replaced by an updated, non-generic wall type. Framed walls and Railings will also acquire 
1/2” (13 mm) thick layers of sheetrock on each side.

6. Stairwells defined by railings

Interior railings that used a generic, single-layer wall type drawn in older program versions 
will acquire layers of sheetrock when the plan is opened in version X8. This can affect the 
appearance of staircases where they join to a floor platform. To address this issue, select 
the railing and move it 1/2” (13 mm) away from the top edge of the staircase. 

7. Deck rooms

In legacy plans opened in Chief Architect X8, Deck rooms with Advanced Deck Framing built 
retain the framing but have Automatic Deck Framing turned off by default. Decks with no 
Advanced Deck Framing built are converted to Balcony rooms.

8. Material definitions and light sources

Settings in the Define Material dialog that affect materials’ appearance of brightness have 
been modified. The Ambient setting was removed, and the Diffuse setting for materials in 
legacy plans will be set to 100% when opened in version X8. 

The Quality setting for light sources set to use Soft Shadows in ray tracing was also 
modified. Lights using Soft Shadows in legacy plans will be set to use Medium quality. The 
Light Diameter of light sources in legacy plans is capped at 4” (100 mm).

9. Structural Member Reporting

When a plan created in Chief Architect X2 or prior is opened in Chief Architect X8, Materials 
Lists are set to calculate Total Lineal Length. For a combination of lineal length and piece 
count, select Mixed Reporting in the Structural Member Reporting dialog.

10. Fill New Framing Members

In Chief Architect X2 and prior, Fill New Framing Members was view-specific; in Chief 
Architect X8 it applies to the entire plan. As a result, it is turned off by default in legacy 
plans opened in version X8.

New and Improved Features
The following is a list of new and improved features in Chief Architect Version X8.

Program Overview
• Added support for 3D Connexion's 3D mice.
• Enhanced support for basic math in dialogs and when moving objects using dimensions.
• The Move edit handle of a selected framing object, Soffit, or group-selection will now 

shift position to remain on-screen when you zoom in.
• Improved how names with numbers at the end are sorted in the Project Browser.

File Management

• The Backup Entire Plan  tool now automatically creates a zipped folder.
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• New Missing Files dialog assists in handling of missing referenced graphics files.

Preferences and Default Settings
• New Enable ‘Show Room Labels’ Automatic Behavior When Changing Room Types set-

ting in the Preferences dialog gives the option of leaving Show Room Labels unchecked 
when a Room Type is assigned to a room.

• New Reset Toolbars button in the Preferences dialog.

Layers
• Layer sets can now be renamed.

Editing Objects

• New Object , Room , Floor , and Plan  Modes for the Object Painter tool.

• New properties including Fill Style can be applied using the Object Eyedropper  and 
Apply Properties  tools.

• New Elevation Reference setting for a variety of architectural objects lets you specify 
where their height is measured from.

• The heights of various architectural objects can now be measured from either their top 
or bottom surface.

• The Edit Object Parts toggle has been replaced by a Connect CAD Segments  toggle, 
Disconnect Edges  tool, and Disconnect Selected Edge  edit tool.

• Sticky Mode  is now available for the Break Line  edit tool.

• New Complete Break  edit tool replaces double-clicking the Break Line  edit but-
ton.

• New Corner Edit Handles  and Edge Edit Handles  toggles for the Break Line  
edit tool.

Walls, Railings, and Fencing
• The Wall Specification dialog now has a LABEL panel. 
• Railing newels, balusters, and rails can now be displayed in floor plan view.

• Wall Hatching  now only covers wall layers that are set to display, improving its usabil-
ity with railings. 

Rooms
• Living Area labels are no longer created for structures that are not included in the Living 

Area Calculation such as detached garages and decks.

• New Make Room Area Polyline  edit tool creates a polyline showing the extents of its 
Standard Area.

• Deck Planking and Joists can now be specified as Treated.
• Improved how deck joists are generated when Border Planks have been specified.
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• Improved how deck joists and planking are automatically generated when deck joists 
have been rotated.

• Improved ability of planking in separate deck rooms to miter along an angled Room 
Divider.

• Improved how deck planking is automatically generated for adjacent decks.
• The Display in Uppercase checkbox for room labels was moved to the TEXT STYLE panel of 

the Room Label Specification dialog.

Doors and Windows
• Doors and windows can now span the intersections of straight, collinear walls.
• Corner windows can now be pushed further into a wall corner to produce a minimal cor-

ner post. 
• Fixed glass corner windows can now have no corner post. 
• Architectural objects like cabinets will now bump against door and window casings and 

sills. 
• When a wall type is specified for a Bay, Box, or Bow Window placed in a Pony Wall, it 

now replaces both wall types and spans the entire unit. 

Foundations

• Slabs  now have a LABEL panel in their specification dialog. 

• Slabs  now have a Footing Offset setting in their specification dialog. 
• Post footings can now be specified as Round or Square. 

Roofs
• New Roof Defaults dialog is accessible via the Default Settings dialog. 
• Roof framing can now be generated at the same time as roof planes in the Build Roof 

dialog. 
• The Surface, Structure, and Ceiling layers of roof planes can now be specified.

• The Surface, Structure, and Ceiling layers of roof planes can now be Auto Detailed .
• The Framing Member Type can now be specified for the rafters of individual roof and 

ceiling planes.
• New option for a Rebuild Fascia and Roof Trim hotkey. 

Stairs, Ramps, and Landings
• Stairs and Ramps now have object preview panes in their specification dialogs.
• New Top Height Reference settings control where a staircase’s Top Height measures to. 
• New Break Line settings allow you to create a break or cut line with optional transpar-

ency on staircases.
• New settings for creating stair railing returns and extensions.
• Stair and ramp newels, balusters, and rails can now be displayed in floor plan view.
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• New “Stair & Ramp, Details” layer controls the display of stair and ramp overhangs and 
tread nosing in floor plan view.

• New “Stair & Ramp, Stringers” layer controls the display of stair stringers in floor plan 
view.

• New Handrail at Wall settings allow railing returns and extensions.
• The Stringer Top and Bottom values in the Staircase Specification dialog are now mea-

sured from the top front and bottom back corners of stair treads, respectively. Both can 
now be set to zero, as well.

• Improved how stairs snap to nearby walls. 

Framing
• Improved wall framing around floor/ceiling beams. 
• New Rotate options in the Framing Specification dialog allow you to rotate and align 

wall framing and blocking within the wall framing layer. 

• Wall Blocking  now displays as a box with a single diagonal line when cut by a cross 
section plane.

• Improved information text in Wall Detail   views.
• When multiple sill plates are specified, only the bottom one is now Treated. 

Trusses
• The text of truss labels can now be specified. 
• Unnecessary Measurements information removed from the Truss Base Specification 

dialog.
• Automatic Truss label numbering now begins with 1 instead of 0.

Cabinets
• Enhanced control of face items on cabinet sides and back.
• New “Door - Hinge Bottom” and “Door - Hinge Top” face items create awning and hop-

per doors.
• New “Side Panel - Applied” and “Side Panel - Inset” face items.
• New Full Overlay and Extend to Bottom options for side panels.
• New Floor to Top setting in the Cabinet Specification dialog.  
• Box construction, overlay, and corner treatment settings are now grouped on the new 

BOX CONSTRUCTION panel in the Cabinet Specification dialogs.  
• New Lock from Auto Resize option for cabinet face items. 
• The list of cabinet face items is now alphabetized. 
• Cabinet front settings can now be modified when multiple cabinets are selected. 
• New Always Present option places cabinet feet under cabinets that are not end cabi-

nets.
• New Retain Toe Kick option preserves the toe kick on cabinets with cabinet feet.
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• Improved functionality of Stretch to Fit option for toe kicks.
• Cabinet feet no longer display on Corner cabinets.
• The Custom Countertop and Custom Backsplash Specification dialogs now have a LABEL 

panel.

Plants and Sprinklers
• New “Unknown” option for plant Hardiness Zones.  
• New Object Type filter in the Plant Chooser dialog.  

The Library
• Improved Library Search sorts the most relevant results first. 
• The Export Library command is now available for the User Catalog. 
• All specification settings are now saved when a symbol object is added to the library. 

Materials

• Improved ability to paint a single wall in a room using the Material Painter . 
• Improved interface of the MATERIALS panel. 

3D Views

• The Cross Section Slider  now supports multiple cutting planes. 
• Enhanced panning and zooming in Perspective 3D views. 

• New 3D Focus on Object  tool. 

• Zoom Using Field of View setting replaced by the Perspective Crop Mode toggle . 

• The active Sun Angle , Toggle Shadows , and Toggle Sunlight  status are saved 
on a per-camera basis. 

Rendering and Ray Tracing

• New Adjust Sunlight  tool opens the Adjust Sunlight dialog.

• Sun Angles  and the Generic Sun are no longer listed in the Adjust Lights dialog. 
• The Generic Sun now has a defaults dialog.
• The Generic Sun can now be set to follow the camera. 

• The active Sun Angle  can now be specified on a per-camera basis. 

• Sun Angles  now derive their date format from your operating system settings. 
• The Opaque Window Glass option was moved from the 3D View Defaults dialog and 

made available for most Rendering Techniques. 

• New Toggle Shadows  tool. 
• Show Shadows moved from the Preferences dialog to the Camera Defaults dialog.
• Shadows are now supported in the Vector View Rendering Technique.
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• Now Shadow Intensity option for the Vector View and Technical Illustration Rendering 
Techniques.

• Show Shadows can now be specified per camera view.
• Improved handling of reflective surfaces in Ray Trace views.

Dimensions

• New Auto Story Pole Dimensions  tool.
• New Blank Segment setting added to the SEGMENTS panel of the Dimension Line 

Specification dialog (formerly the ADDITIONAL TEXT panel).
• New Location settings for automatic elevation dimensions.
• New Elevation Marker settings for vertically oriented dimension lines in cross section/

elevation views.

Text, Callouts, and Markers
• New Ellipse, Capsule, Diamond, and Rectangle callout shapes for Callouts.
• Callouts and Markers now have an object preview in their specification dialogs. 

• New options for specifying the Alignment of Level Line Marker  text. 
• New Uppercase option for Text Styles as well as Rich Text.

CAD Objects

• New Blocking Box  tool draws a CAD box with a single diagonal line through it.

Importing and Exporting
• Import of .skp files created in SketchUp version 2016 is now supported.

• Import and export of .dxf//dwg files created in AutoCAD® version 2016 is now sup-
ported.

Custom Symbols

• New Show Origin  option for custom symbols in the Symbol Specification dialog.
• New Use Imported UV Map option in the Symbol Specification dialog.
• The Height off Floor setting was moved from the Symbol Specification dialog to the reg-

ular specification dialog. 
• Obsolete Components button removed from the Symbol Specification dialog. 

Printing and Plotting
• Super B (13” x 19”) and E1 (30” x 42”) sheet sizes added to plan and layout template 

files. 

Layout
• New Live View options for camera views, overviews, and cross section/elevation views 

sent to layout.
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• New Color Fill option for Vector Views sent to layout using Plot Lines.

Schedules and Object Labels
• New schedule columns allow you to insert dynamic object previews into most types of 

schedules.

• New Framing Schedule  tool can be used to create framing, deck framing, and truss 
schedules.

• New Ellipse, Capsule, Diamond, and Rectangle callout shapes for schedule labels.
• Object labels and schedules now support multiple lines of text.
• CAD objects as well as CAD-based architectural objects like slabs now have labels. 
• The Display All Text in Uppercase setting for schedules replaced by Uppercase style 

option for Text Styles.

Materials Lists
• New Include Hidden Columns option when exporting a Materials List. 
• The Structural Member Reporting dialog can now be accessed via the Tools menu. 
• New Structural Member Reporting Method drop-down in the toolbar lets you change 

the reporting method used by an active Materials List.

Ruby Console
• New named values for layers, stairs, cabinets, and trusses.


